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About This Release

ABOUT THIS RELEASE
This document describes the enhancements for ERDAS IMAGINE 2016 v16.1, including IMAGINE
Photogrammetry (formerly LPS Core) and ERDAS ER Mapper. Although the information in this document is
current as of the product release, see the Hexagon Geospatial Support website for the most current version.
This release includes both enhancements and fixes. For information on fixes that were made to ERDAS IMAGINE
for this release, see the Issues Resolved section.
This document is only an overview and does not provide all of the details about the product's capabilities. See the
online help and other documents provided with ERDAS IMAGINE for more information.

ERDAS IMAGINE PRODUCT TIERS
®

ERDAS IMAGINE performs advanced remote sensing analysis and spatial modeling to create new information. In
addition, with ERDAS IMAGINE, you can visualize your results in 2D, 3D, movies, and on cartographic-quality map
compositions. The core of the ERDAS IMAGINE product suite is engineered to scale with your geospatial data
production needs. Optional modules (add-ons) providing specialized functionalities are also available to enhance
your productivity and capabilities.
®

IMAGINE Essentials is the entry-level image processing product for map creation and simple feature collection
tools. IMAGINE Essentials enables serial batch processing.
®

IMAGINE Advantage enables advanced spectral processing, image registration, mosaicking and image analysis,
and change detection capabilities. IMAGINE Advantage enables parallel batch processing for accelerated output.
®

IMAGINE Professional includes a production toolset for advanced spectral, hyperspectral, and radar processing,
and spatial modeling. Includes ERDAS ER Mapper.

NEW PLATFORMS
ARCGIS 10.4.1
ERDAS IMAGINE 2016 v16.1 has been tested and declared Supported when using an installed and licensed
version of ArcGIS 10 through 10.4.1 in order to provide Geodatabase support libraries. Alternatively the IMAGINE
Geodatabase Support component (based on ArcGIS Engine 10.1) can be installed to provide Geodatabase
support.

WINDOWS 10
ERDAS ER Mapper is supported on Windows 10 with the release of the v16.1 Update

September 29, 2016

4

New Technology

NEW TECHNOLOGY
IMAGINE SAR FEATURE
One of the key development areas targeted for this update of ERDAS IMAGINE was to release a new add-on
module called IMAGINE SAR Feature.
IMAGINE SAR Feature is an interactive Operational Workstation which enables an Analyst to optimize radar image
processing and viewing in a real-time environment. Using the Workstation, advanced SAR algorithms can be
rapidly modified and viewed to allow enhancement optimization. The full image can then be processed into
Information Products. Available functionality includes speckle suppression, image annealing, Target Detection,
Change Detection and Feature Extraction. Functionality can be combined into processing regimens to convert
radar imagery from any sensor into industry-standard information. The Workstation is fully integrated within
ERDAS IMAGINE and is sold as an add-on module.
Functionality appears on the SAR Feature tab of the ERDAS IMAGINE icon panel


Operational Workstation – All functionality is designed into a process-flow driven Workstation. All Tools
and algorithm parameters are in one place.



Fast Image Display – Geometric and radiometric image adjustments are applied on the fly, preserving
integrity of original pixel values



All algorithms are state-of-the-art and radar-specific



Algorithms are designed for computational efficiency, taking advantage of both multi-core and mixed CPUGPU computing



Smart Enhancement optimization – Image Enhancement and Information Extraction no longer requires
time-consuming trial-and-error; the Analyst can optimize processing in near real-time



Dynamically Adjust Imagery – Analyst can modify image processing regimen and see the results
immediately



Precise Mensuration – Image raster is geocoded on-the-fly into the Viewer. All measurements are based
on original pixel values, image metadata and a true radar sensor model.
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OVERVIEW
The SAR Feature Workstation consists of a viewer, panels to manage data, a Smart Control, and a dedicated icon
panel with interactive process-flow algorithm parameters

REQUIREMENTS


IMAGINE SAR Feature is an ERDAS IMAGINE add-on delivered with the ERDAS IMAGINE 2016 v16.1
installer. A separate license must be purchased to activate this functionality.



To fully utilize the computational sophistication of IMAGINE SAR Feature, ERDAS IMAGINE 2016 v16.1
should be installed on a modern CPU with multicore capability and with an advanced video card (from
NVIDIA) so as to enable the GPU processing via CUDA (Compute Unified Device Architecture). The
software is capable of running on just the CPU in the absence of a suitable GPU environment, however
this is not recommended.



To determine if your GPU is supported, or to select an optimal system for your application, please visit the
Nvidia web site. This page will indicate the Compute Capability of the various Nvidia cards available.
IMAGINE SAR Feature will require Compute Capability 2.0 or higher. CUDA 7.5 is being used, therefore
Nvidia driver v352.39 or above must be installed.
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New Technology

NEW OPERATORS FOR SPATIAL MODELER
Based on initiatives, such as the creation of Hexagon Smart M.Apps, Hexagon Geospatial has continued to add
new operators to Spatial Modeler. This section is listing of the new (or modified) operators with a brief description
of their capabilities. Please refer to the ERDAS IMAGINE 2016 v16.1 Help for full details of each operator, as well
as to the Hexagon Geospatial Community / Spatial Recipes page for examples of Spatial Models which use many
of these capabilities.

COMPUTE AFFINE COEFFICIENTS

Compute coefficients of a 2D affine transformation using offsets, rotation, and scales.

CREATE AFFINE TRANSFORM

Create an affine transformation based on input affine coefficients, source CRS, and target CRS.
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CREATE RSETS

The Create RSETs operator has had two new ports added.
The ForceRecompute flag indicates what the behavior of the operator is with regards to existing RSETs. By
default RSETs are computed if the file specified on the FilenameIn port already has identifiable pyramids. Even
when ForceRecompute is set to false this operator always attempts to optimize RSET access by persisting
metadata about the identified pyramids to the full resolution dataset.
The SubsamplingMethod port allows you to specify the name of the algorithm to be used for sub-sampling the
RSETs. Valid values are "Auto", "Standard", "MaxPixelDecimation", and "Epho3x3"

DEFINE METADATA

Creates or modifies an object containing Metadata for a raster dataset.
Metadata can be read from a raster dataset using the Raster Input operator (with Read Metadata = true). The
Metadata object contains a small number of common fields corresponding to input ports of the Define Metadata
operator: DatasetReference, Classification, Sensor, etc. Metadata values in supported formats that correspond to
these fields are translated when reading. Other metadata in the raster are put in the FormatSpecific field, and can
be accessed using the Dictionary Item operator.
Metadata can be written to a new raster dataset by using the Define Metadata object to attach a Metadata object
just before writing with the Raster Output operator. When possible, top-level fields such as Classification and
Sensor are translated to the metadata schema of the raster file format.
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DEFINE SECURITY INFO

Creates a Security Info metadata object suitable for writing to raster images in formats that support it, including
NITF. These security-related fields follow the NITF 2.1 file header definition as specified in section 6.1.2.1 of MILSTD-2500C. They include the fields whose acronyms beginning with "FS", except FSCOP and FSCPYS.

FEATURES INFORMATION

Provides basic information about features, including the number of geometries, projected coordinate system,
extent, etc.

GET DRA PARAMS

Dynamic Range Adjustment (DRA) is a technique used to perform tonal processing of raw image data, mapping it
from the dynamic range of the sensor to that of a well-defined metric. The Get DRA Params operator can be used
to acquire the necessary inputs to use with the DRA Stretch operator.
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This operator has been modified and extended to better support the dynamic nature of DRA stretching in SIPS
Image Chains.
The EMinAdjIn and EMaxAdjIn inputs specify minimum and maximum DN values for the DRA stretch range. If
provided, these completely override PMinIn, PMaxIn, and any defaults for the specified InteractiveChain. The
output ports EMinAdjOut and EMaxAdjOut provide similar tables containing the minimum and maximum DN
values for the generated stretch range, whether or not EMinAdjIn and EMaxAdjIn were specified.

GET PIXEL VALUE

Read raster pixel values at a point. The output is an IMAGINE.List of IMAGINE.Scalar objects, one for each raster
band. If a given band has NODATA at the specified x, y location, the list item for that band will be null rather than
IMAGINE.Scalar.
When MapOrFile is set to "File", the coordinate inputs X and Y are interpreted as File coordinates. When
MapOrFile is set to "Map", the coordinate inputs X and Y are interpreted as Map coordinates in the map
coordinate reference system of Raster.

ORTHORECTIFY

This Operator has been extended to include a SquarePixels port which enables the output data to be forced to
have square pixel dimensions even if other inputs would suggest non-square.

RASTER TO BITMAP

The Raster to Bitmap operator has a new output port called IsGreyscale which indicates whether BitmapOut is
greyscale or not (so a client application displaying the bitmap can alter its behavior accordingly).

REMOVE GEOREFERENCING
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Removes the geo referencing of a raster dataset.

REMOVE ITEM

The Remove Item operator removes values from a Dictionary or List. The output is a copy of the DataIn input with
the specified items deleted.
Multiple items can be removed by using Add Port from the operator’s context menu to add additional Item inputs.

SET THEMATICITY

Sets or clears the IsThematic flag on a raster stream.
The thematic flag is primarily used by the Raster Output operator to indicate whether the output image should be
marked (by default) as thematic or athematic. It also changes some calculations done by the Statistics operator.

STACK LAYERS

The Stack Layers operator has been modified so that Input1 and Input2 are not Required ports. This is particularly
useful when passing the output of an Iterator to Stack Layers since the Iterator can return a variable number of
outputs, including only one (or none). Previously the Stack Layers would have failed if not passed two or more
inputs.

WARP

The Warp Operator has been extended to include a UsePyramids port. By default this port is set to True since it
will result in faster processing, especially when Previewing a Spatial Model. However using pyramids from
upstream data can sometimes result in unexpected results, especially if altering the pixel sizes of the original data.
For example, consider a model where you want to input a 0.6m athematic panchromatic image, filter those 0.6m
pixel values using a 4x4 smoothing kernel, but then alter the spatial resolution of the Model to 2.4m (using a Warp
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and Define Processing Area). If the Warp operator were allowed to use pyramids that might be available for the
input image file it would only ever access pyramid layer 2 (a 4x reduction in resolution) to process in the model
since the output pixel size is 4x less than the input. Consequently pyramid layer 2 would be filtered, not the original
1:1 pixels (pyramid 0), resulting in a very blurry output. Setting the UsePyramids port to False would force the
Spatial Model to pull data through the Warp operator at 1:1 and therefore the filtering would be applied at the
expected resolution.

GENERAL SPATIAL MODELER
SUBSET DIALOG
In prior versions of ERDAS IMAGINE running Subset did not transfer Elevation Info, NoData masks, and other
Metadata associated with the input image to the output subset. With this release the dialog now utilizes the Spatial
Modeler and so is capable of retaining (or, in the case of NoData, introducing) these items of metadata, as well as
providing additional output file formats.

UPLOAD MODEL TO SMART M.APP
For those customers building their own Smart M.Apps, the Spatial Model Editor now includes an option to upload a
Spatial Model to M.App Studio to facilitate using the model as a geoprocessing Spatial Recipe in a Smart M.App.
This provides an efficient methodology for customers to build, test and validate their models in ERDAS IMAGINE
prior to transferring them for use in the Smart M.App environment.
Please note that for the upload utility to operate you will need to subscribe to the IMAGINE M.App Connect
application (available at no additional cost from the M.App Exchange).

GENERAL ERDAS IMAGINE
SUPPORT FOR WEB (PSEUDO) MERCATOR
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Data from the National Map (and other sources) is distributed using a Web Mercator projected coordinate system.
Support for this system has been added.

DELTACUE
The DeltaCue change detection and monitoring utility now supports imagery from the Sentinel-2 and Landsat 8
platforms

SYSTEM REQUIREMENTS
ERDAS IMAGINE (INCLUDING ERDAS ER MAPPER, IMAGINE
PHOTOGRAMMETRY AND ORIMA)
64-bit: Intel 64 (EM64T), AMD 64, or equivalent
Computer/ Processor
(Multi-core processors are strongly recommended)

Memory (RAM)

Disk Space

8 GB minimum, 16 GB strongly recommended, especially for 64-bit systems



4 GB for software



7 GB for example data

Data storage requirements vary by mapping project1



Windows® 7 SP1 or higher, Professional and Ultimate (64-bit)



Windows® 8 (Standard), Professional and Enterprise (64-bit) 4



Windows® 8.1 (Standard), Professional and Enterprise (64-bit) 4



Windows 10 Pro (64-bit) 4



Windows Server® 2008 R2 SP1 (64-bit)



Windows Server 2012 R2 (64-bit)



OpenGL 2.1 or higher (this typically comes with supported graphics cards 5)



Adobe® Reader® 7 or higher



Internet Explorer® 7 and higher with JavaScript enabled, or Firefox® 3 and higher with
JavaScript enabled



Java Runtime 1.7.0.80 (optional install, required for Web Process Service (WPS)
publishing to APOLLO Professional. IMAGINE Objective requires JRE, but can utilize any
installed and configured JRE of version 1.7.0.80 or higher)



Python 3.4 (32-bit is highly recommended for best compatibility, but 64-bit is Viable for

Operating Systems 2, 3

Software

September 29, 2016

13

System Requirements
background processing). Python is optionally usable with Spatial Modeler.

Recommended Graphics
Cards for Stereo display

Recommended Stereo
Display Monitors



Microsoft DirectX® 9c or higher



.NET Framework 4.0



MSXML 6.0



Visual Studio 2013 Express Edition can be used with ERDAS ER Mapper’s dynamic
algorithm compiler



NVIDIA® Quadro® K5200, K4200, K2200, K420 6



NVIDIA Quadro K5000, K4000, K600 6



120 Hz (or above) LCD Monitors with NVIDIA 3D Vision™ Kit

7

All software installations require:


One Windows-compatible mouse with scroll wheel or equivalent input device



Printing requires Windows-supported hardcopy devices 8

Software security (Intergraph Licensing 11.13.2) requires one of the following:


Ethernet card, or



One USB port for hardware key

Advanced data collection requires one of the following hand controllers: 9

Peripherals

ArcGIS, GeoMedia and
Database Interoperability
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TopoMouse™ or TopoMouse USB™



Immersion 3D Mouse



MOUSE-TRAK



Stealth 3D (Immersion), S3D-E type, Serial Port



Stealth Z, S2-Z model, USB version



Stealth V, S3-V type (add as a serial device)



3Dconnexion SpaceExplorer mouse 10



EK2000 Hand Wheels



EMSEN Hand Wheels



Z/I Mouse



ERDAS IMAGINE can be installed on a computer with any version of GeoMedia higher
than 2014 installed. However for proper compatibility, it is recommended that GeoMedia is
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installed first and that the versions correspond.


Live linking will work between any released version of ERDAS IMAGINE 2016 and
GeoMedia 2016.



ERDAS IMAGINE can interact with both types of personal Geodatabases (*.mdb and
*.gdb).



ERDAS IMAGINE can be installed on a computer that has ArcGIS® versions 10 through
10.4.1.



ERDAS IMAGINE and IMAGINE Photogrammetry can interact with ArcGIS Server 10
Geodatabase servers (ArcSDE). To read or interact with an Enterprise Geodatabase, you
must either:







o

Install and license the appropriate version of ArcGIS for Desktop versions 10
through 10.4.1, OR

o

Install the IMAGINE Geodatabase Support (based on ArcEngine 10.1), which
requires no license

Oracle Server 12c can be used to store/read raster data as,
o

Oracle GeoRaster (.ogr) (requires Oracle Spatial),

o

SDE Raster (.sdi) (requires ArcGIS for Server) ,

Oracle Server 12c can be used to store/read vector/feature data as,
o

Oracle features (.ofp).

o

Oracle Spatial Features (.ogv) (requires Oracle Spatial),

Microsoft SQL Server 2014 can be used to store/read vector/feature data as,
o

SQL Server Features (.sfp)

ERDAS
IMAGINE SYSTEM REQUIREMENTS NOTES
1

Disk I/O is usually the slowest task in geospatial data processing. Faster hard disks improve productivity.
Reading data from one disk, writing temporary data to a second disk, and writing data to a third disk improves
performance. Disk arrays improve productivity, but some RAID options slow performance. Network disk drives are
subject to network limitations.
2

Server Operating Systems are not supported for IMAGINE Photogrammetry, ORIMA or ERDAS ER Mapper.

3

The 3D stereo viewing and peripheral requirements of IMAGINE Photogrammetry limit its operating system
options.
4

ERDAS ER Mapper is not supported on Windows 8. It is considered Viable on Windows 8.1.

5

Windows provides a generic OpenGL driver for all supported graphics cards. However, an OpenGL-optimized
graphics card and driver are recommended for these applications.
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6

Graphics cards certified with previous versions of IMAGINE Photogrammetry and ORIMA may also be
compatible, but are not certified in the current version.
7

Stereo Monitors certified with previous versions of IMAGINE Photogrammetry and ORIMA may also be
compatible, but are not certified in the current version.
8

HP-RTL drivers are recommended. Windows 64-bit print servers require 64-bit print drivers.

9

®

Stealth S-Mouse (S2-S model) and MOUSE-TRAK are the only supported hand controllers in Stereo Analyst for
ERDAS IMAGINE.
10

3Dconnexion SpaceExplorer mouse is supported in IMAGINE Photogrammetry.

PRO600
64-bit: Intel 64 (EM64T), AMD 64, or equivalent
Computer/ Processor
(Multi-core processors are strongly recommended)

Memory (RAM)

4 GB minimum, 8 GB strongly recommended



1 GB for software

Disk Space
Data storage requirements vary by mapping project11



Windows® 7 SP1 or higher, Professional and Ultimate (64-bit)



Windows® 8 (Standard), Professional and Enterprise (64-bit)



IMAGINE Photogrammetry 2016 12



One of the following products from Bentley Systems, Inc

Operating Systems

12

o

MicroStation V8i (SS1- SS3 Update 1)

o

Bentley Map V8i (SS1 - SS3 standalone or for MicroStation)

o

Bentley Map Enterprise V8i (SS1 - SS3)

Software

Recommended Graphics
Cards

Recommended Stereo
Display Monitors
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NVIDIA® Quadro® K5200, K4200, K2200, K420 13



NVIDIA Quadro K5000, K4000, K600 13



120 Hz (or above) LCD Monitors with NVIDIA 3D Vision™ Kit
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All software installations require:


One Windows-compatible mouse with scroll wheel or equivalent input device



Printing requires Windows-supported hardcopy devices 15

Software security (Intergraph Licensing 11.11.1) requires one of the following:


Ethernet card, or



One USB port for hardware key

Advanced data collection requires one of the following hand controllers: 16

Peripherals



TopoMouse™ or TopoMouse USB™



Immersion 3D Mouse



MOUSE-TRAK



Stealth 3D (Immersion), S3D-E type, Serial Port



Stealth Z, S2-Z model, USB version



Stealth V, S3-V type (add as a serial device)



3Dconnexion SpaceExplorer mouse



EK2000 Hand Wheels



EMSEN Hand Wheels



Z/I Mouse

PRO600
SYSTEM REQUIREMENTS NOTES
11

Disk I/O is usually the slowest task in geospatial data processing. Faster hard disks improve productivity.
Reading data from one disk, writing temporary data to a second disk, and writing data to a third disk improves
performance. Disk arrays improve productivity, but some RAID options slow performance. Network disk drives are
subject to network limitations.
12

Any further requirements defined by any of the listed apply implicitly to PRO600.

13

Graphics cards certified with previous versions of PRO600 may also be compatible, but are not certified in the
current version.
14

Stereo Monitors certified with previous versions of PRO600 may also be compatible, but are not certified in the
current version.
15

HP-RTL drivers are recommended. Windows 64-bit print servers require 64-bit print drivers.

16

Stealth S-Mouse (S2-S model) and MOUSE-TRAK are only supported in Stereo Analyst for ERDAS IMAGINE.
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ISSUES RESOLVED
IMAGINE ESSENTIALS
CR #

Summary – IMAGINE
Essentials

Description / How to Reproduce

1-LWV52P

Gokturk MS images are
shifted and scaled incorrectly
when displayed in the 2D
viewer

The symptom is that the Pan data is displayed correctly, but the MS data is scaled incorrectly
and also shifted.

“Number of simultaneous
commands” in the IMAGINE
Preference will not take over
correctly

Customer reported that the “Number of simultaneous commands” as set by IMAGINE
Preference, will not be taken into account, when starting a batch job using the submit option.
Once you click the Submit button, in the Submit dialog, the number of “Simultaneous
process” shows 1, even if you have set more than the value 1 in the simultaneous commands
setting in Preference for Batch. To recreate the problem, please do the following:

1-BC025L

1.

Go to IMAGINE Preference > Application> Batch Processing > Set the “Number of
simultaneous commands” as more than 1, as for example 6 > Save.

2.

Launch IMAGINE TIFF importer

3.

After loading one input file and naming output file, Click OK

4.

In the Import TIFF window, click the “Batch” button.

5.

Change your variable and add more files

6.

Then click “Submit button”, you will see that The number of “Simultaneous Process”
shows as 1, which should, as per Preference setting be, 6. But that has not been taken
over correctly.

When you manually change the number of processes to a higher number, in the batch
process, it correctly runs with the number entered in the Submit window.

1-BJ4AO6

ERDAS IMAGINE not
persisting metadata correctly
when importing ASTER data

Customer reported that ERDAS IMAGINE is not persisting metadata correctly when
importing ASTER data. According to the customer, the ASTER importer has this problem
from ERDAS IMAGINE 2014 v14.1 onward. It extracts the band 3n and 3b images and
create a blockfile using those two data, but IMAGINE Photogrammetry gives error message:
“Failed to get metadata for” the added image.

NITF 2.1 export with
embedded JPEG2000
compression can not handle
NoData value in the input
image.

Customer reported that if NoData is defined in the raster file, Export to NITF with JPEG200
compression option gets disabled. The customer is using GeoTIFF data from Pleiades
images. The problem has been recreated with Pleiades as well as with other TIFF and IMG
data. However if the NoData value is removed from the input file, the JPEG2000
compression option in the NITF export dialog doesn’t get disabled. To recreate the problem
please do the following:

1-H8JX9N

1. Open the IMAGINE Exporter > Select the export format as NITF 2.1 from Imagery , and
add your input data > OK
2. You will see an alert about the image mask. If you continue without dropping the mask
size, you will see that the “change compression“ option gets disabled. But if you lower the
number of masks you can see that Change compression option remains active.
3. However if I remove the NoData Value from the Input image and do the NITF export the
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Change compression option remains enabled

1-JM6H0T

1-L1U03E

ERDAS IMAGINE does not
read projection information on
JP2 imagery from the
National Map

Open a National Map JP2 image in ERDAS IMAGINE (2015 or 2016) and note that no
projection information is recognised. Open it in another GIS package and it is reported as
being in Web Mercator Auxilliary Sphere.

Help for Landsat 8 importer
has incorrect specification of
which MSI bands are
imported

This is particularly important to fix because the table in the Help is the *only* indication to the
user as to what wavelengths the imported bands represent and is therefore currently highly
misleading. Go to the Manage Data tab and click Import Data. Select the "Landsat 7 or
Landsat 8 from USGS " option, select a valid .tar.gz input, specify an output and click OK. In
the tertiary dialog which comes up click Help. The resulting Help file includes a table which
states that a Multispectral composite will consist of bands :1, 2, 3, 4, 5, 7, 9 This is incorrect.
Band 6 is missing from the list, and band 9 (the Cirrus cloud band) should not be included.
The actual Multispectral bands for Landsat 8 are: 1, 2, 3, 4, 5, 6, 7

Sentinel-2 dll not selecting
correct bands for sub-images

The 10m bands in a Sentinel-2 image are supposed to be 02, 03, 04 and 08 (equating to the
usual B, G, R, NIR wavelengths). However if you open a Sentinel-2 image using the
"Only10MeterBnads" sub-image option it does not appear to load the correct bands - the
fourth band of the image (which is supposed to be Band 08) does not appear to be Band 08.
It might be Band 05, but it certainly isn’t Band 08. You can test this by starting two 2D Views
and loading one with the Sentinel-2 image loaded using defaults (which will load all 13 bands
at 10m resolution) and the second using the Sub-Image tab and the "Only10MeterBands"
option selected. On the Multipsectral tab, use the band pull-downs to manual set the RGB
display to 08, 04, 03 and note that the displays are different

ERDAS IMAGINE displays
artefacts in Sentinel-2
imported images.

Customer reported that ERDAS IMAGINE 2016 displays artefacts in Sentinel-2 when
imported. According to the customer if they instead use the RGB importer in ESA’s SNAP
v3.0, those artefacts are not found.

1-LRPIQJ

The ERDAS IMAGINE 2016 software is working as designed - when opening a Sentinel-2
image which covers more than one UTM zone the granules must be reprojected to a
common projected coordinate system. So if the image covers both Zone 31 and Zone 32, all
the zone 31 granules might be reprojected to Zone 32. This reprojection is performed using
Nearest Neighbor resampling and so the standard NN resampling "artefacts" are observed in
those granules that have had to be reprojected. Such effects become more frequent the
further away from the base Zone you proceed.

1-LRRTXR

For v16.1 we will alter the default behavior from NN resampling to Cubic Convolution (IM34140). The SAFE dataset will still be opened as a single image, but the visual appearance
of the resampling applied to granules that must be reprojected will be minimised by the use
of CC resampling.
For ERDAS IMAGINE 2017 an enhancement request has been submitted requesting that the
dataset be openable as Zone-specific sub-images so that resampling can be avoided (but at
the cost of only accessing a zone-specific section of the image at a time, as is provided by
SNAP).

1-QLCKZK

ERDAS IMAGINE 2016
crashes while opening
Sentinel-2 Level 2A
atmospheric corrected data

Customer reported that IMAGINE 2016.0 crashes while opening Sentinel-2 Level 2A
atmospheric corrected data in *.SAFE format.

1-BM7ATC

Python API (help)- Please
add a link to Operator
Limitation in Workflow.

Description from customer: In the "Python Scripting in Spatial Modeler Workflows" it states
under the heading Operator Limitations "The syntax for a given operator is documented in
the Spatial Model Editor online-help" but there is no link from here
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Unable to connect to Google
Earth Pro.

When Google Earth Pro is installed users are unable to connect to it from ERDAS IMAGINE.
In ERDAS IMAGINE 2016 v16.1 the Google Earth tab has been re-enabled to be visible and
to interact with Google Earth.

1-KX0K1N

The Google Earth connection will also work with Google Earth Pro, but the necessary API is
only installed with Google Earth, so you must install it as well.
Also note that Google has ceased support for the API used for this feature. Therefore, the
Google Earth connection may cease to operate with future releases of Google Earth / Google
Earth Pro.

Problem building pyramids
and statistics

Customer reported that ERDAS IMAGINE crashed while performing ISOCLASS classification
with 368 band hyperspectral data. The following error occurs while creating the statistics
and pyramid: Error: “Warning in ethr_ThreadCreate: Thread creation failed: Not enough
storage is available to process this command”.

1-M7JGP8

“Correct the Alert problem” remains even after recreating
pyramids using "Edit Image
Metadata”

After computing pyramids using the "Edit Image Metadata" dialog, when you load the images
again they sometimes still come up with “Correct the Alert problem” in the table contents and
it still reads that pyramids need to be updated...and one has to run it again.

Create Map Composition operator fails to generate an output when the Operating System
region is set to Netherlands. The same work flow executed successfully with an English OS.

1-QK5K4B

With region set as
Netherlands, Create Map
Composition operator fails
when the OS region is set to
Netherlands.

1-QK5K6B

Create Geospatial PDF
operator fails when the OS
region is set to Netherlands.

Create Geospatial operator fails to generate an output when the Operating System region is
set to Netherlands. The same work flow executed successfully with an English OS.

Some projections missing in
finland plb file

Enhancement request to add the following EPSG projections from epsg.plb to finland.plb:
EPSG:3067 , EPSG:5048, EPSG:25834, EPSG:3046, EPSG:25835, EPSG:3047,
EPSG:25836, EPSG:3048, EPSG:3045, EPSG:3049

Incorrect name for
EPSG:3067

In ERDAS IMAGINE 2016, the EPSG:3067 entries are shown as: "ETRS89 / ETRSTM35FIN (3067)"

1-LC793Y

1-LBFZUT

1-LD8QW4
However according to EPSG Registry (epsg-registry.org), the official name is: “ETRS89 /
ETRS-TM35FIN(E,N)”

1-RCVW1M

EPSG code 25832 and 4647
are mixed up

When exporting an *.img formatted image to a TIFF format, its EPSG code is incorrectly
changed from 25832 to 4647. This causes wrong positioning of the exported image

Incorrect parameters for
EPSG:5650

The parameters of EPSG 5650 in epsg.plb is different from the official definition of
EPSG:5650 in the EPSG registry.

1-ROZSSD
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1-FN8U7B

Drag and dropping files within
a ShoeBox duplicates the file
instead of just moving it.

When you drag and drop a file within a Shoebox the file is duplicated instead of simply being
moved. There is no need to have two entries of the same file in the ShoeBox. It used to work
correctly in ERDAS IMAGINE 2014.

1-QKIBSI

ERDAS IMAGINE 2016 is
unable to open standard
v1.1.1 WMS

Customer reported that ERDAS IMAGINE 2016 is unable to open standard v1.1.1 WMS.
Same services open successfully in other GIS applications/

IMAGINE PHOTOGRAMMETRY
CR #

Summary – IMAGINE
Photogrammetry

Description / How to Reproduce

1-DSTPZJ

XPro SGM, exclusion
polygon

XPro SGM online help mentions that exclusion polygon is supported but this option is not
available in the SGM dialog.

RPC generation tool doesn't
generate accurate RPC00B
format RPCs from WV OR2A
block file.

Exporting to ISAT project is not possible if the block file is set in Rational Functions geometric
model. I have tested the workaround "Using the RPC generation tool, you can generate
adjusted RPC's from the block file in RPC00B format. You can then create an IKONOS
ImageStation project with the exported RPC files." In order to test the accuracy of the
generated RPCs I have created a block file in IKONOS RPC model and added imagery and
RPC00B format RPCs. There is huge shift in IKONOS RPC block that I created after RPC
generation. In my triangulated WV RPC block GCPs were right on spot. The data is on:
\\alpha\Siebel_Bug_Data\1-OT8X2F

1-LC9W5H

Point Cloud Classify tool is
not writing the projection of
the input las data to the
output file.

Classify tool in Point Cloud is not writing projection information in the output file if the
projection is stored in aux file, not from the input las file.

1-M0O60Y

Point Cloud to Raster
operator is not creating
correct RGB raster

Point Cloud to Raster operator is not creating RGB raster output from Point cloud RGB
encoded input data. The output image shows Intensity, Green and Blue.

1-LWVDOP

Error messages when
displaying LAS 1.4 data in 2D
viewer

Some Point cloud data in LAS 1.4 format are not displayed properly in IMAGINE 2D viewer.
You will get several error messages when trying to load the data.

1-OT8X2F

IMAGINE PROFESSIONAL
CR #

Summary – IMAGINE
Professional

Description / How to Reproduce

1-KYQVLT

Signature Editor crashes
when merging signatures with
negative values

Signature Editor crashes when merging signatures that contain negative values in their
statistics.
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1-B9XSYL

1-BC4AGD

1-KZ8EKT

1-L51HZL

Incorrect error creating submodel.

In the Spatial Model Editor selecting seemingly continuous groups of Operators and trying to
create a sub-model from the selection can result in an error message: "Cannot create
subprocess from this selection. Must select a continuous piece of the model."

Renamed Commandline
operator set back to default
commandline name after
editing anything in the
operator

Customer reported that a renamed Commandline operator is set back to its default
commandline name after editing anything in the operator. This is a problem for user having
multiple CommandLine operators in the same model. When they edit anything in the
renamed commandline operator, the operator immediately changes it’s name to the default
name, even though you had renamed it before starting to edit. Then Spatial Modeler
complains that there are several with same commandline name.

Summary operator causes
instability (and crash) of
ERDAS IMAGINE

Using a specific Zonal Summary model which basically takes a shapefile as raster as the
Zones, a floating point image as the Class Raster and feeds them into Summary. Run the
model once and it completes. Change the multiplier (from 10000 to 1), or some other
parameter of the model, and run again and ERDAS IMAGINE crashes. Sometimes it even
crashes the first time you run.

Typing @ and hitting Enter in
Operator properties crashes
ERDAS IMAGINE

Start a Spatial Model Editor. Drag the Eq operator onto the canvas. Select the Operator. In
Properties, place cursor in the Value field of Input2 and type @ and then hit Enter. ERDAS
IMAGINE crashes. This was encountered because of trying to type "2D", but had the Shift
key held down when typing the 2.

Large (multi-GB) ECW files
will no longer Preview in
NDVI

Display large (multi-GB) ColorIR ECW in 2D View.
On the Raster tab select NDVI.

1-LSDYMN
On the NDVI GUI click Preview.
Note that the results never display.

Create RSETs crashes
ERDAS IMAGINE if image
has previously been opened

Display (specific) TIFF in a 2D View.
Clear the View.
Start Spatial Model Editor.
Add a Create RSETs operator.

1-LWW5C9

Define the TIFF as the input file.
Click Run.
ERDAS IMAGINE crashes.

1-M0H0QW

OLH for Attach Vertical CRS
is out of date

The OLH for Attach Vertical CRS does not match the released version of the operator. It has
the wrong port names and refers to rasters only.

1-M0HN27

Spatial Model ran in Beta, but
fails to run in Release

A specific model no longer runs in ERDAS IMAGINE 2016, but did apparently run in the Beta
build 5306. When Run, it runs for about 50 minutes and then crashes ERDAS IMAGINE

1-M0O5O2

“Point Cloud to Raster”
operator is creating partial

Point Cloud to Raster operator generates partial output raster image. For instance, the
output raster may be created only for the left half of the point cloud data extent.
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output raster image

Define Processing Area
changing pixel size of ortho
image
1-M19F6D

Running an ortho raster through Define Processing Area, with all of the options (including
Cell Size) set to "same as input 1", creates a raster with a slightly different pixel size. The
specific model tested has two paths RasterIn->RasterOut and RasterIn>DefineProcessingArea->RasterOut. The grid, cell size, window and CRS options of the
DPA operator are all set to the single, input raster. The input image is an ortho in
Geographic (Lat/Lon) with a cell size with many, many decimal places. The output of the
RasterIn->RasterOutput path is a raster with _exactly_ the same Map Info as the input. The
output of the RasterIn->DefineProcessingArea->RasterOut path is a raster with _almost_ the
same Map Info as the input, but the pixel size is _slightly_ different (4.9526297953637308e006 vs 4.9526297953630142e-006).

IMAGINE ADVANTAGE
CR #

Summary –IMAGINE
Advantage

Description / How to Reproduce

CSM Plugin Manager will not
register CSM.dll

CSM.dll cannot be added in the CSM plugin. The CSM is for a specific sensor. To replicate:
File > Configuration > CSM Plugin Manager - Use CSM Plugin library selector to select
CSM.dll.

1-LX0KBG

At this point the Runtime Library menu is updated to Visual Studio 2008 but no model is
added to the Available Models section.

1-LW6IFI

MosaicPro produces line gap
between abutting edges of
tiles with the same projection

A single line gap is seen when mosaicking tiles that have abutting edges and are registered
to an identical projection. The viewer mosaics the tile together as expected.

IMAGINE AUTO DTM
CR #

1-LR240I

Summary – IMAGINE
Auto DTM

Description / How to Reproduce

Tridicon SGM crashes when
generating pyramid layers

For aerial frame projects, if images do not have pyramids in the format needed by Tridicon
SGM, the process generates those pyramid layers. In ERDAS IMAGINE 2016, SGM crashes
during the pyramid generation process.

IMAGINE STEREO ANALYST
CR #

1-KZ8UR1

1-MEG1CN

Summary – IMAGINE
Stereo Analyst

Description / How to Reproduce

Y Parallax at the oriented A3
imagery in Stereo Analyst

There is a large y-parallax in Stereo Analyst for IMAGINE that is not seen in Terrain Editor.
Zooming in to a better ratio than 1:1 or setting epipolar update mode to motion doesn't
remove the y-parallax.

Opening Space Imaging
IKONOS Stereo Pair in
Stereo Analyst for IMAGINE

Steps to reproduce:
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crashes

1. Launch ERDAS IMAGINE, Stereo Analyst from Toolbox tab > Stereo Analyst.
2. Launch File > Open > Space Imaging IKONOS Stereo Pair
3. Select the file *_metadata.txt file
4. Stereo Analyst for IMAGINE hangs and crashes

PRO600
CR #

Summary – PRO600

Description / How to Reproduce

1-JSPK9S

Cursor hangs in MicroStation
window.

When working with ADS data, the cursor in MicroStation window does not follow the cursor in
the viewplex window. As you roam in the viewplex window, the cursor in the MSTN window
hangs and catches up when the cursor in the viewplex window stops moving.
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ABOUT US
Hexagon Geospatial helps you make sense of the dynamically changing world. We enable you to envision,
experience and communicate geographic information. Our technology provides you the form to design, develop
and deliver solutions that solve complex, real-world challenges. Ultimately, this is realized through our creative
software products and platforms.
CUSTOMERS. Globally, a wide variety of organizations rely on our products daily including local, state and
national mapping agencies, transportation departments, defense organizations, engineering and utility companies,
and businesses serving agriculture and natural resource needs. Our portfolio enables these organizations to
holistically understand change and make clear, reliable decisions.
TECHNOLOGY. Our priority is to deliver products, platforms and solutions that make our customers successful.
Hexagon Geospatial is focused on developing technology that displays and interprets information in a
personalized, meaningful way. We enable you to transform location-based content into dynamic and useable
business information that creatively conveys the answers you need.
PARTNERS. As an organization, we are partner-focused, working alongside our channel to ensure we succeed
together. We provide the right platforms, products, and support to our business partners so that they may
successfully deliver sophisticated solutions for their customers. We recognize that we greatly extend our reach and
influence by cultivating channel partner relationships both inside and outside of Hexagon.
TEAM. As an employer, we recognize that the success of our business is the result of our highly motivated and
collaborative staff. At Hexagon Geospatial, we celebrate a diverse set of people and talents, and we respect
people for who they are and the wealth of knowledge they bring to the table. We retain talent by fostering individual
development and ensuring frequent opportunities to learn and grow.
HEXAGON. Hexagon’s solutions integrate sensors, software, domain knowledge and customer workflows into
intelligent information ecosystems that deliver actionable information. They are used in a broad range of vital
industries.
Hexagon (Nasdaq Stockholm: HEXA B) has more than 16,000 employees in 46 countries and net sales of
approximately 3.4bn USD. Learn more at hexagon.com and follow us @HexagonAB.
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Product Documentation Terms of Use
PLEASE READ THESE TERMS CAREFULLY BEFORE USING HEXAGON GEOSPATIAL’S DOCUMENTATION ("DOCUMENT"). USE OF
THIS DOCUMENT INDICATES ACCEPTANCE OF THIS AGREEMENT WITHOUT MODIFICATION. IF YOU DO NOT AGREE TO THE
TERMS HEREOF ("TERMS"), DO NOT USE THIS DOCUMENT.
Use Of This Document
All materials in this Document are copyrighted and any unauthorized use may violate worldwide copyright, trademark, and other laws. Subject
to the terms of this Agreement, Hexagon Geospatial (a Division of Intergraph Corporation) and Intergraph’s subsidiaries ("Intergraph") hereby
authorize you to reproduce this Document solely for your personal, non-commercial use. In consideration of this authorization, you agree to
retain all copyright and other proprietary notices contained therein. You may not modify the Materials in any way or reproduce or publicly
display, perform, or distribute or otherwise use them for any public or commercial purpose, except as specifically authorized in a separate
agreement with Hexagon Geospatial.
The foregoing authorization specifically excludes content or material bearing a copyright notice or attribution of rights of a third party. Except as
expressly provided above, nothing contained herein shall be construed as conferring by implication, estoppel or otherwise any license or right
under any copyright, patent or trademark of Hexagon Geospatial or Intergraph or any third party.
If you breach any of these Terms, your authorization to use this Document automatically terminates. Upon termination, you will immediately
destroy any downloaded or printed Materials in your possession or control.
Disclaimers
ALL MATERIALS SUPPLIED HEREUNDER ARE PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR
PURPOSE, OR NON-INFRINGEMENT. Hexagon Geospatial does not warrant that the content of this Document will be error-free, that defects
will be corrected, or that any Hexagon Geospatial Website or the services that make Materials available are free of viruses or other harmful
components.
Hexagon Geospatial does not warrant the accuracy and completeness of this Document. Hexagon Geospatial may make changes to this
Document at any time without notice.
Limitation Of Liability
IN NO EVENT SHALL HEXAGON GEOSPATIAL BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL OR CONSEQUENTIAL
DAMAGES, OR DAMAGES FOR LOSS OF PROFITS, REVENUE, DATA OR USE, INCURRED BY YOU OR ANY THIRD PARTY, WHETHER
IN AN ACTION IN CONTRACT OR TORT, ARISING FROM YOUR ACCESS TO, OR USE OF, THIS DOCUMENT.
Indemnification
You agree to defend, indemnify, and hold harmless Hexagon Geospatial, its officers, directors, employees, and agents from and against any
and all claims, liabilities, damages, losses or expense, including reasonable attorneys fees and costs, arising out of or in any way connected
with your access to or use of this Document.
Use Of Software
Use of software described in this Document is subject to the terms of the end user license agreement that accompanies the software, if any.
You may not download or install any software that is accompanied by or includes an end user license agreement unless you have read and
accepted the terms of such license agreement. Any such software is the copyrighted work of Hexagon Geospatial, Intergraph or its licensors.
Links To Third Party Websites
This Document may provide links to third party websites for your convenience and information. Third party websites will be governed by their
own terms and conditions. Hexagon Geospatial does not endorse companies or products to which it links.
Third party websites are owned and operated by independent parties over which Hexagon Geospatial has no control. Hexagon Geospatial shall
not have any liability resulting from your use of the third party website. Any link you make to or from the third party website will be at your own
risk and any information you share with the third party website will be subject to the terms of the third party website, including those relating to
confidentiality, data privacy, and security.
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Trademarks
The trademarks, logos and service marks ("Marks") displayed in this Document are the property of Hexagon Geospatial, Intergraph or other
third parties. Users are not permitted to use Marks without the prior written consent of Hexagon Geospatial, Intergraph or the third party that
owns the Mark. "Intergraph" is a registered trademark of Intergraph Corporation in the United States and in other countries. Other brands and
product names are trademarks of their respective owners.
Find additional trademark information.
Procedure For Making Claims Of Copyright Infringement
Notifications of claimed copyright infringement should be sent to Hexagon Geospatial by mail at the following address: Intergraph Corporation,
Attn: Intergraph Legal Department, P.O. Box 240000, Huntsville, Alabama 35824.
US Government Restricted Right
Materials are provided with "RESTRICTED RIGHTS." Use, duplication, or disclosure of Materials by the U.S. Government is subject to
restrictions as set forth in FAR 52.227-14 and DFARS 252.227-7013 et seq. or successor provisions thereto. Use of Materials by the
Government constitutes acknowledgement of Hexagon Geospatial or Intergraph’s proprietary rights therein.
International Use
You may not use or export Materials in violation of U.S. export laws and regulations. Hexagon Geospatial makes no representation that
Materials are appropriate or available for use in every country, and access to them from territories where their content is illegal is prohibited.
Hexagon Geospatial provides access to Hexagon Geospatial international data and, therefore, may contain references or cross references to
Hexagon Geospatial products, programs and services that are not announced in your country. These references do not imply that Hexagon
Geospatial intends to announce such products, programs or services in your country.
The Materials are subject to U.S. export control and economic sanctions laws and regulations and you agree to comply strictly with all such
laws and regulations. In addition, you represent and warrant that you are not a national of, or otherwise located within, a country subject to U.S.
economic sanctions (including without limitation Iran, Syria, Sudan, Cuba, and North Korea) and that you are not otherwise prohibited from
receiving or accessing the Materials under U.S. export control and economic sanctions laws and regulations. Hexagon Geospatial makes no
representation that the Materials are appropriate or available for use in every country, and access to them from territories where their content is
illegal is prohibited. All rights to use the Materials are granted on condition that such rights are forfeited if you fail to comply with the terms of
this agreement.
Revisions
Hexagon Geospatial reserves the right to revise these Terms at any time. You are responsible for regularly reviewing these Terms. Your
continued use of this Document after the effective date of such changes constitutes your acceptance of and agreement to such changes.
Applicable Law
This Document is created and controlled by Hexagon Geospatial in the State of Alabama. As such, the laws of the State of Alabama will govern
these Terms, without giving effect to any principles of conflicts of law. You hereby irrevocably and unconditionally consent to submit to the
exclusive jurisdiction of the United States District Court for the Northern District of Alabama, Northeastern Division, or the Circuit Court for
Madison County, Alabama for any litigation arising out of or relating to use of this Document (and agree not to commence any litigation relating
thereto except in such courts), waive any objection to the laying of venue of any such litigation in such Courts and agree not to plead or claim in
any such Courts that such litigation brought therein has been brought in an inconvenient forum. Some jurisdictions do not allow the exclusions
or limitations set forth in these Terms. Such exclusions or limitations shall apply in all jurisdictions to the maximum extent allowed by applicable
law.
Questions
Contact us with any questions regarding these Terms.
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